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A Letter from the Head Prefect 

Hey students! It’s Jocelyn, the 

Head Prefect of the Student Life 

Organization. I hope you have 

had a great February! Are you 

excited to return to hybrid 

learning? SLO is working hard on 

planning new and fun activities 

for both virtual and in-school 

students and ensuring a 

successful year. As you all may 

know, this month is Black 

History Month! Here is a little 

information about an 

influential civil rights activist, 

Medgar Evers!  

 

 

 

that year, Evers became the first secretary of the 

NAACP. In addition to playing an important role in 

finally desegregating the university when they were 

forced to register James Meredith in 1962, he also 

arranged economic boycotts of white owned 

companies that were discriminatory. He also fought 

racial mistreatment in how state and local legal 

systems handled crimes against African Americans, 

for example calling a new investigation on the 

case of Emmett Till. On June 12th, 1963, Evers was 

assassinated by a white supremacist. However, his 

influential actions, such as organizing boycotts and 

fighting racial injustices and segregation, made 

him the well-remembered activist he is today. 

Medgar Evers was an African American civil rights 

activist, who became known as the first secretary 

of the NAACP. Evers was born in Decatur, 

Mississippi on July 2nd, 1925. After his successful 

years in college, he became involved in a civil 

rights organization called the RNCL, which gave 

him pivotal training in activism. In this 

organization, he helped organize their boycott of 

gas stations that refused to let black people use 

their restrooms. Then, in 1954, Evers applied to the 

then-segregated University of Mississippi and got 

rejected. In response to this, he and the National 

Association for the Advancement of Colored 

People (NAACP) generated a campaign to 

desegregate the school. During December of 
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Have you been tuning in to our Goodnight CCSL series on our school 

YouTube channel? If not, be sure to check it out if you want 

to hear children’s books read by Dr. Hodgdon and some of our 

students. Also, since it’s February you know what that means, 

Valentine’s Day! If you want to make a handmade gift for your 

parents to show them your love and care, you can find below how to 

make an ASL “I love you” card. Lastly, the Pollard Memorial Library is 

offering a reading program called the “Chilly Challenge” that 

students in Grade 4 and under can participate in. The deadline to 

sign up for the “Chilly Challenge” is March 6 so make sure to sign up 

as soon as you can! This challenge consists of a combination of 

reading, doing activities, and submitting online book reviews which 

can earn you digital badges. Students that earn 8 digital badges by 

March 6 will be entered into a raffle for a prize bag! You can sign up 

online at https://lowelllibrary.beanstack.org/reader365   

ASL “I love you” card (A great Mother’s Day gift!):   

What you'll need:   

Any color construction paper   

Any skin-colored construction paper   

Scissors   

Glue   

Glitter, buttons or other decorations (optional)   

1. Fold your construction paper in half to form the base of the 

card.   

2. On the skin-colored construction paper, trace your hand and 

cut it out.   

3. Fold the ring finger and the middle finger down to form the “I 

love you” sign in ASL.   

4. (Optional) Decorate the front of the card with decorations.   

5. Glue the hand to the cover of the card.   

6. Write a message on the inside of the card!   

 

https://lowelllibrary.beanstack.org/reader365
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ACADEMIC DEPARTMENT 
With Kristine P. 

 

  

 

 

  

You can also format text 

directly by using the other 

controls on the Home tab. 

On the Insert tab, the 

galleries include that are 

designed to coordinate 

with the overall look of 

your document. You can 

use these galleries to insert 

tables, headers, footers, 

lists, cover pages, and 

other document. 

On the Insert tab, the 

galleries include items that 

are designed to 

coordinate with the 

overall look of your 

document. You can use 

these galleries to insert 

tables, headers, footers, 

lists, cover pages, and 

other document building 

blocks. 

You can easily change 

the formatting of selected 

text in the document text 

by choosing a look for the 

selected text from the 

Quick Styles gallery. 

On Thursday, February 12th, the Academic Department held their 

first Kahoot Trivia Night for Grades 3-5 and 6-10. This event gave 

students the ability to play and test their general knowledge against 

their peers to win prizes!  

We had 4 winners: Sotara R. (10B), Kaemon K. (10B), Dhara P. (3C), 

and Daniel M. (5B). Students were asked a variety of questions 

relating to the topics they were currently learning in class and other 

trivia about Collegiate Charter School of Lowell and Black History 

Month. It was amazing to see students come together and learn 

something new while having fun.   

SLO is looking for tutors! If you are interested in volunteering, have 

any academic needs, or have any other questions, email 

slo@lowell.sabis.net.   

 

SOCIAL RESPONSBILITY DEPARTMENT 
With Jennaly K.  

The Social Responsibility Department had their second 

interview! We interviewed a chocolate company called 

BonBonBon for a Valentine’s Day special! A few prefects 

from my department and others, including Nathan M., 

Jessica H., Cynthia K., Khadija T., and Jocelyn P. had the 

opportunity of interviewing Alexandra Clark, the founder and 

president of BonBonBon, about her company, how it started, 

and tips for anyone who wishes to become an entrepreneur 

one day! Check the interview here: 

https://youtu.be/yqfVbB8w92w  

https://youtu.be/yqfVbB8w92w
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MANAGEMENT DEPARTMENT  
With Ranu P.  

Black History Facts: 

· Historian Carter G. Woodson, the creator of what is presently known as 

Black History Month, worked passionately to establish the event in an 

effort to provide an education on the origins, struggles, and 

achievements of African Americans in United States history. 

· The date of February 12, 1909 was chosen for the NAACP’s inception 

because it also marked the 100th birthday of President Abraham 

Lincoln and coincided with abolitionist Fredrick Douglass’s birthday 

(February 14). 

· On February 12, 2021, the National Association for the Advancement 

of Colored People (NAACP) will celebrate its 112th birthday. Its 

America’s oldest civil rights organization, as well as its largest. 

· Martin Luther King, Jr was assassinated on Maya Angelou’s birthday, 

April 4, 1968. After this, Angelou stopped celebrating her birthday. 

· Onesimus, an enslaved African brought to the Massachusetts colony, 

told church minister Cotton Mather about the way inoculations were 

practiced in Africa for centuries to prevent people from getting sick. 

Mather took this information to Dr. Zabdiel Boylston when smallpox 

became a severe issue in Boston in 1721. Boylston inoculated 240 

people, despite a large opposition to the practice. 

· In the United States and Canada, we celebrate Black History Month in 

February. However, in the United Kingdom, Ireland, and the 

Netherlands, they honor it during the month of October. 

· At just 15 years old, Claudette Colvin pre-dated Rosa Parks in refusing 

to give up her seat on public transportation. 

 

WELLNESS DEPARTMENT  
With Sotara R.  

Hey wolves! Did you know that every Wednesday at 3:30-4:30 p.m. the Wellness Department 

hosts a Wellness Support group for high school students? We’ve been going over topics such as 

“covid anxiety” and “stress about planning for the future”. It provides a safe space for students 

to talk about how they are feeling. Please join by checking for the link on your TEAMS calendar. 

If you would like us to re-send the link please email us at slo@lowell.sabis.net.   

mailto:slo@lowell.sabis.net
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ACTIVITIES DEPARTMENT  
with Vani B.  
The Activities Department is hosting SLO’s 2nd Kahoot Night! We will 

have a Disney themed Kahoot for 2nd – 4th grade, Music/Pop Culture for 

5th – 7th grade and Women’s History for 8th – 10th grade. All three 

Kahoots will be on Friday, March 19th. The 1st place winner in each 

category will win a $25 gift card! Keep an eye on your school email 

account for more details! 

SPORTS DEPARTMENT with Brooke T., Kaemon W. & Makarios K.  

The Sport Department, interviewed our Athletic Director, Mr. Jeff Shanahan, about the upcoming 

sports season. 

1. How are the tryouts and Practices going to take place? 

Shanahan: Not determined but it would be (like normal tryouts) but it would be difficult to find a 

field in like February and March. 

2. Are there going to be any new jerseys? 

Shanahan: No, we will not be getting new shirts. It's not cost effective and the current uniforms are 

fairly new. There is really no need, as of right now, to get any new uniforms or sponsored uniforms. 

3. Are there going to be any fans at the games, or will it just be Recorded/Streamed? 

Shanahan: That is to be determined. 

4. What are going to be the procedures for Fall 2 Sports? 

Shanahan: We would follow what the State of Massachusetts has in place. Following the MCSAO 

and MIAA regulations for COVID-19. 

5. Could we have Charity/Fundraiser games? For example, play a friendly match and raise money 

for something the school may need. 

Shanahan: Yes, we could do fundraisers to purchase sweat suits/ sweatshirts. 

6. How long will the season be? 

Shanahan: Really Short, Maybe 5 - 6 weeks 

7. Will the cheerleaders be going to soccer games? 

Shanahan: No, the cheer team would be competitive and not cheering at games. 

8. Are we going to play with our masks on? 

Shanahan: Yes, always, and continue to be as socially distant as possible. 

9. Will there be any temperature checks prior to practices or games? 

Shanahan: Yes, and you would have to be COVID-Free to participate. (TBD) 

10. Will we have to continue to dress formal on game day? 

Shanahan: That’s something for athletes to discuss with their coaches whether to dress formal or in 

sweat suits. 

We appreciate you taking the time to sit with us and discuss the upcoming sports season. Our 

fingers are crossed that covid-19 rates will continue to decrease so that we may participate this 

season. 
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OUTREACH DEPARTMENT  
with Emily D.  

Happy Black History Month! In this link 

presented to you we will be focusing on 

Cicely Tyson. Ms. Tyson was an African 

American actress who has won countless 

awards and had been activing for over 

70 years! Cicely co-starred with several 

well-known actors such as Tyler Perry, 

Denzel Washington and Maya Angelou. 

Watch the interview 

here: https://youtu.be/QcUh-jaSlCw  

Check-in with the SLC 
with Ms. Bailey  
 

Why is it important to learn about Black History? 

Have you ever wondered why we celebrate Black History Month? Learning the history 

of African Americans is a huge part of learning how America itself became what it is 

today. We utilize this month to remember the struggles and triumphs of those that 

came before us and with this we learn to create a better future for all. The first 

recorded ship of slaves sailed to North America in August of 1619, 400 years ago the 

White Lion carried Angolans from Africa to what is now Hampton, Virginia to help the 

British settlers build their colonies off the backs of free laborers.    

Over these 400 years, laws and alliances were created to end slavery and to make 

sure that every American, regardless of race, receives equal treatment and 

opportunities within the United States. Though we still face social injustice and racism 

today, communities like Collegiate have triumphed in being a haven for those of all 

backgrounds to be given the best education possible for a chance at a successful 

future. Learning the past will continue to allow us to not repeat our mistakes and 

make the world a better place for all.    

In celebration of Black History Month, here’s a video of poems from the book “Woke: 

A Young Poet’s Call to Justice”. Enjoy! Click the link to 

watch: https://youtu.be/xOsse579CXo    

 

https://youtu.be/QcUh-jaSlCw
https://youtu.be/xOsse579CXo

